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Please read the following important information

1. You can download and print the Class Notes for personal use, but you may not share them.

2. Once you have watched all the videos and completed all the quizzes, reflections, tasks and assessments
successfully, you can download your certificate and print it.

3. If you wish to earn SACE Professional Development (PD) points for this session, you must complete all the online
assessments in the session successfully. Our system will notify us of your success, and we will send the points
allocation request to the South African Council for Educators (SACE).

4. Remember that devices and apps are updated all the time. The device specifications and features that you see
here might differ slightly from those of the device you are using. The app features and icons that you see here
might also differ slightly from the app in which you are working.
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Outcomes and content

Outcomes of the session

By the end of the session, the participant will be able to:

« explain the importance of effective file management
« explain how folders work in File Explorer
* use File Explorer effectively

create, name, rename, move, sort and delete files and
folders

use the Recycle Bin effectively

identify different file types, their extensions and associated
apps

identify and explain the uses of different storage types:
external storage, CDs and DVDs, flash drives, external hard
drives, zip files, and Cloud Storage

Content of the session

This session will focus on:

file management

using File Explorer

creating, naming, renaming, moving, sorting and deleting
files and folders

the Recycle Bin

file types, extensions and associated apps

different storage types (external storage, CDs and DVDs,
flash drives, external hard drives, zip files, and Cloud
Storage)
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Overview

Welcome to Session 2: Managing files. In this session, you will learn how to organise the files
on your laptop efficiently for more productive work.

During this course — Using your laptop to make a real difference in your teaching — you
will learn all about how to use your laptop. The course includes the following sessions.

Your first laptop

Managing files

Connecting to the world

Using a display device with your laptop

Making it work with JUST ONE LAPTOP

S

If you would like to learn more about using all the Microsoft Office Apps on your laptop as well
as your mobile device, please consider enrolling for our Microsoft 365 Course, where you will
learn all about using Microsoft Word, Excel, PowerPoint, and OneNote. Discover how to use
Microsoft Teams in a teaching context in our Teaching Online Course.

If you have — in addition to your laptop — a Windows tablet, learn all about how to use your
tablet in Using your Windows tablet device to make a real difference in your teaching.

If you have an Android tablet device, find out how to use it optimally in Using your Android
tablet device to make a real difference in your teaching. Also consider enrolling for our
Google Workspace Course, where you will study a variety of Google Apps, including Docs,

Sheets, Slides, Keep and Drive.

Well done for making this investment in your professional development as a teacher and a 21st
Century Citizen.

© Via Afrika — These pages may not be shared. 1



Introduction

Why should you manage your files?

It is important to safely and efficiently organise, store and
access your saved documents. As teachers, you will often need
to find and use documents you created previously, for example
a test that you created a year ago or a circular that you received
a week ago. If you start organising your files properly from the
beginning, you won't waste any time hunting through hundreds
of disorganised documents to find what you need.

In the same way you've always organised your physical
documents in your classroom using ring-binders and display
books, you will need to organise the documents you create on
your laptop computer.

Having your documents stored in an organised, easily
accessible manner will save you time. It will also allow you to
use and build on previously created documents which can
significantly reduce prep time and save you having to recreate
something you've already done. All-in-all, managing your files
well is a very good idea.

Reflection

« How do you currently manage your files and folders? Do
you have a filing cabinet in your classroom?

« Have you ever organised digital or electronic files on a
device, such as your laptop, tablet or smartphone?

« Make notes in your PD Journal.

File management

Just like the cupboard in your classroom where you neatly store
your ring-binders containing all those important documents,
your laptop also systematically stores your electronic
documents. These electronic documents are called files and
they are stored in folders, which work much like ring-binders.
Folders can contain files as well as subfolders.
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File management is the process of naming, storing and
retrieving the files on your computer.

Here is an example of how files and folders can be organised
on a computer.

Documents
1

2017 to Maths English FAL
2020 Grade 4 Grade 5
Term 1 Term 1
Results

« There is a folder named Documents which has two
subfolders saved in it.

« The Tests subfolder contains its own subfolder called 2017
to 2020. It also contains two files, a Word file called Maths
Grade 4 Term 1 and an Excel file called English FAL Grade 5
Term 1 Results.

« The Circulars subfolder contains two Word files: Maths IP
Workshop and SACE CPTD.

This structure makes it easy to find the various files you have
created over time.

Reflection

* Make a list in your PD Journal of which tips and tricks
have worked well in your own physical document filing
system.

 Start jotting down ideas in your PD Journal about how
you would like to organise the files on your laptop.

Circulars

Maths IP
Workshop

SACECPTD
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File Explorer

Accessing File Explorer

Microsoft's file management app is called File Explorer. You will
see it as a standard icon on the Windows Taskbar. If you do not
see it, you can follow the instructions below to install the icon
on the Taskbar for easy access in the future.

All  Apps Documents ~ Web More ¥ g
Best match
T_' File Explorer -
App ™M
Settings .

File Explorer
=) File Explorer Options > App
ft File Explorer Developer Settings >
< Sync File Explorer and other settings > = Open
f Show full path in title bar > 58 Unpin from Start

) o
fF Show hidden files > Ribfolesioer

2

M:
Documents - This PC & Manage
- i = Map network drive

&) T2L1 Accessing File Explorer.tscproj >

52 Disconnect network drive
Search work and web

Properties
£ File EXplorer - See work and web results >

A~

£ file explorer windows 10 >

Pinned

i i > =

£ file explorer options M Desktop
L file explorer download > B8 Pictures
£ file explorer app >
£ File Explorer

The File Explorer Icon in the Taskbar

You can install the File Explorer Icon on the Taskbar.

1. Click on the Start Button on the Taskbar (or press the
Windows Key on your keyboard).

The Start Menu will appear.

Without clicking anywhere else, type the following words
into the Search Bar: File Explorer.

4. The File Explorer App will appear on the Start Menu.
5. Right-click the File Explorer Icon and left-click Pin to Taskbar.

The File Explorer Icon is now permanently available on your
Taskbar for quick access in future.

You can access the contents of your computer from the File
Explorer Icon on the Taskbar.

1. Click on the File Explorer Icon.

2. Windows 10 will open the app.
You are ready to explore the contents of your laptop now.
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Find the File Explorer App on your laptop and identify the
Documents Folder.

Getting to know File Explorer

File Explorer uses the same elements you are used to from
other Microsoft Apps. You will see Tabs at the top, with the
Ribbon containing different Command Groups below that.

Title Bar: Shows the name of the folder you are working in.

Title Bar

3

| < | Documents

Home Share View
) A / B v [&5] v
* =) B gy Cut < g x ‘—ip % New item _st Open E Select all
=) W] Copy path £ Easy access ~ [} Edit 95 select none
Pin to Quick Copy Paste _ Move Copy Delete Rename New Properties e
access [ﬂ Paste shortcut to~ to~ - folder - £ History @] Invert selection

Clipboard Organize New Open Select

&« 5> v > ThisPC > Documents

Name Date mod\i/fied Type Size
s Quick access
@ Class list.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
fia Media24 Head Office  32) Mark sheet.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
@ OneDrive - Media24 } @ Assessment Test.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Classroom notes.docx 2021/03/27 21:01 Microsoft Word D... 0KB
[ This PC I3 Announcement.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Lesson presentation.pptx 2021/03/28 00:04 Microsoft PowerP... 0KB

¥ Network

Tabs: File, Home, Share, View.
Tabs

3

| = | Dlacuments

File Home Share View
) A / B v [&5] v
* By lj & cut < [ S x LiIJ T New item AL Open - [ selectall
= W Copy path -ﬁ Easy access ¥ [T Edit 55 Select none
Pin to Quick Copy Paste _ Move Copy Delete Rename New Properties e
access [ﬂ Paste shortcut to~ to~ - folder - &) History 5 Invert selection

Clipboard Organize New Open Select

&« 5> v > ThisPC > Documents

Name Date mod\i/fied Type Size
s Quick access
@ Class list.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
fia Media24 Head Office  32) Mark sheet.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
@ OneDrive - Media24 } @ Assessment Test.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Classroom notes.docx 2021/03/27 21:01 Microsoft Word D... 0KB
[ This PC I3 Announcement.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Lesson presentation.pptx 2021/03/28 00:04 Microsoft PowerP... 0KB

¥ Network
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Ribbon: Holds Groups and Command Buttons.
Ribbon

3

EIE

% | Documents

Home Share View
* Sn X cut 1 x : I 7 New item ~ . ilopen - [Fselectal
. W= Copy path - £ Easy access ~ LT Edit 55 Select none
Pin to Quick Copy Paste _ Move Copy Delete Rename New Properties o
access [1] Paste shortcut to~ to - folder - &) History 7 Invert selection
Clipboard Organize New Open Select
S R > ThisPC > Documents
Name Date modified Type Size
# Quick access
@ Class list.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
fia Media24 Head Office  32) Mark sheet.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
/03/27 . 1 A
@ OneDrive - Media24 } @ Assessment Test.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Classroom notes.docx 2021/03/27 21:01 Microsoft Word D... 0KB
E3 This PC £33 Announcement.docx 2021/03/27 21:01 Microsoft Word D... 0KB
l_ﬂ' Setwcik @ Lesson presentation.pptx 2021/03/28 00:04 Microsoft PowerP... 0KB
Address Bar: Displays the path of the folder you are working in.
Address Bar
V'
I ¥ < | Documents
Home Share View
¢ A cut | x I‘ 7 New item ~ ilopen - [Fselectal
= W= Copy path - A £ Easy access ~ LT Edit 55 Select none
Pin to Quick Copy Paste _ Move Copy Delete Rename New Properties o
access [1] Paste shortcut to~ to - folder - &) History 7 Invert selection
Clipboard Organize New Open Select
S R > ThisPC > Documents
Name Date modified Type Size
# Quick access
@ Class list.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
fia Media24 Head Office  32) Mark sheet.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
/03/27 . 1 A
@ OneDrive - Media24 } @ Assessment Test.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Classroom notes.docx 2021/03/27 21:01 Microsoft Word D... 0KB
E3 This PC £33 Announcement.docx 2021/03/27 21:01 Microsoft Word D... 0KB
l_ﬂ' Setwcik @ Lesson presentation.pptx 2021/03/28 00:04 Microsoft PowerP... 0KB
Search Bar: Here, you can search for a specific file or subfolder in the current folder.
Search Bar

[ 72 = | Documents
Home | Share  View
»* | % cut : X I ) New item ~ M Hopen
S5 Copy path - ) easy access ~ €t

Pinto Quick Copy Paste Move Copy  Delete Rename  New Properties

e [&) Pasteshoteut 't~ tor = folder - (@ History

Clipboard Organize New Open
&« > v 4 [H> TisPC > Documents

Nome
# Quick access h
62 Class listxlsx

B33 Mark sheetxlsx
@7 Assessment Test.docx

fi Media24 Head Office

@ OneDrive - Medio2di =
3 Classroom notes.docx
3 This PC @3 Announcement.docx

12 Lesson presentation.pptx

¥ Network

Date modified Tpe Size

2021/03/2721:01  Microso

Hseecan
Setectnone
et selection
setea
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Navigation Pane: Shows a high-level view of the contents of the computer.

« Shows different storage locations (drives) and folders on the computer.
« Quick Access shows folders that are used regularly.

Nagivation Pane

V' N
¥ | Documents
me Share View
m & cut x liﬁ l {7 New item ~ [l open - HHselectall
i Copy path * -‘ £ Easy access ~ [ Edit 55 Select none
Pin to Quick [opy Paste _ Move Copy Delete Rename New Properties - .
access E] Paste shortcut to~ to~ - folder - L@ History EIEI' Invert selection
Clipboard Organize New Open Select
« > v|a > ThisPC > Documents
Name Date modified Type Size
7 Quick access
@ Class list.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
fia Media24 Head Office £33 Mark sheet.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
@ OneDrive - Media24 | @ Assessment Test.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Classroom notes.docx 2021/03/27 21:01 Microsoft Word D... 0KB
This PC I3 Announcement.docx 2021/03/27 21:01 Microsoft Word D... 0KB
& Network @ Lesson presentation.pptx 2021/03/28 00:04 Microsoft PowerP... 0KB
File List: A list of the files in a folder.
File List
V'
I | | = | Documents
Home Share View
* m & cut x liﬁ l T New item ~ [l open - HHselectall
i Copy path € ! £ Easy access ~ [ Edit 55 Select none
Pin to Quick Copy Paste _ Move Copy Delete Rename New Properties - .
access E] Paste shortcut to~ to~ - folder - L@ History EIEI' Invert selection
Clipboard Organize Npw Open Select
« > v 4 > ThisPC > Documents
Name Date mod\i/fied Type Size
7 Quick access
@ Class list.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
fia Media24 Head Office  F33) Mark sheet.xlsx 2021/03/27 21:01 Microsoft Excel W... 7KB
@ OneDrive - Media24 | @ Assessment Test.docx 2021/03/27 21:01 Microsoft Word D... 0KB
@ Classroom notes.docx 2021/03/27 21:01 Microsoft Word D... 0KB
This PC I3 Announcement.docx 2021/03/27 21:01 Microsoft Word D... 0KB
& Network @ Lesson presentation.pptx 2021/03/28 00:04 Microsoft PowerP... 0KB
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Renaming files and folders

You may wish to rename a file or a folder. Windows 10 makes
this task easy.

You can rename files and folders using the Rename Command
on the Ribbon.

1. In File Explorer, make sure the file or folder you want to
rename is visible in the File List.

2. Click the file or folder you want to rename. (You cannot do
this in the Recent Files List in Quick Access. You must select
the actual file or folder you would like to rename.)

3. Click on Rename in the Organise Group on the Home Tab.
4. The file name will become editable.

5. Click in the Text Box and change the name of the file. Do
not change the file extension when you rename a file.

6. Press Enter.

You can rename files and folders using the menu that opens
when you right-click the file or folder.

1. In File Explorer, make sure the file or folder you want to
rename is visible in the File List.

2. Right-click the file or folder you want to rename. (You
cannot do this in the Recent Files List in Quick Access. You
must click on the actual file or folder you would like to
rename.)

3. Left-click on Rename in the menu.
4. The file name will become editable.

5. Left-click in the Text Box and change the name of the file.
Do not change the file extension when you rename a file.

6. Press Enter.

Rename a file in your Documents Folder.
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File naming tips

Creating a new folder

As you create more files in different areas of your work, you will
want to organise them into folders.

You can create a subfolder in an existing folder.

—_

In File Explorer, make sure that the main folder where you
want to place the new folder in is open in the File List.
(Check the Title Bar or Address Bar to be sure.)

Click on the New Folder command in the New Group on the
Home Tab.

no

w

A new folder will appear in the File List with the default
name ‘New Folder".

>

You can rename the folder following the steps you already
know.

© Via Afrika — These pages may not be shared.
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Moving files into a folder

As part of your re-organisation of files, you will want to move
files, or folders, from one place to another on your computer.

You can move files into folders.

1.

no

w

>

v

o

In File Explorer, make sure the file or folder you want to
move is visible in the File List.

Move your cursor over the file you want to move.
Select the file by left-clicking on it once.

Now, click and hold the Left Touchpad Button down while
you drag the file to the folder into which you want to move
it.

When you move the file over the folder, the folder will be
highlighted.

Release the Left Touchpad Button and the file will drop into
the folder.

Create a new folder in your Documents Folder. Name it
Test Folder and move two files into it.

Deleting files and folders

You will find over time that there are files (and even folders
containing many files) that you no longer need. Rather than
using up precious storage space, you can delete them. It is
always best, though, to keep files for as long as you can before
deleting them if you can spare the storage space.

You can delete files and folders using the menu that opens
when you right-click the file or folder.

1.

MW

In File Explorer, make sure the file or folder you want to
delete is visible in the File List.

Right-click the file or folder you want to delete.
Left-click on Delete in the menu.

The file or folder will be removed from the folder and placed
in the Recycle Bin.
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The Recycle Bin

To protect you from accidentally deleting a file, or to help
you get back a file you deleted but now want to use again,
Microsoft Windows uses a Recycle Bin. This is where deleted
files and folders are temporarily stored until we either need
them again or choose to delete them permanently.

You can access files in the Recycle Bin.

1. Go to the Desktop on your laptop.

2. Double-click on the Recycle Bin Icon.

3. The Recycle Bin will open in a new window. Here you will see
all the files that you have deleted.

You can restore a file from the Recycle Bin by moving the file
out of it.

1. Select the file you want to restore by moving your cursor
over it.

2. Right-click on the file and click on the Restore Button.

3. The file will now be moved out of the Recycle Bin and
returned to where it was before you deleted it.

Although the files and folders are deleted and are in your
Recycle Bin, they will still take up storage space. You should
keep your Recycle Bin cleared to save space. But remember,
once you have deleted a file from the Recycle Bin it is almost
impossible to get it back again.

You can empty the Recycle Bin.

1. Open the Recycle Bin.

2. Click on Empty Recycle Bin in the Manage Group on the
Recycle Bin Tools Tab.

3. Windows 10 will delete all the files and folders in the Recycle
Bin and you will regain that space on your hard drive.

+ Delete a file from your Documents Folder.
« Find the deleted file in your Recycle Bin.
* Restore the deleted file.

© Via Afrika — These pages may not be shared.
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Copying files and folders

There will be times when you want to use an existing file and
edit or add to it. For example, you may wish to update class
notes with new information. Rather than replacing the file, you
can create a copy of the file to be the base document of a new
file.

You can copy a file to make a duplicate of it.

1. In File Explorer, make sure the file you want to copy is visible
in the File List.

Move your cursor over the file you want to copy.

Select the file by left-clicking on it once.

Right-click on the file.

Click on Copy on the menu.

Click anywhere on the white space below the other files.
Right-click.

Click on Paste on the menu.

O© © N o U A W

You now have a copy of the file in the same folder.
10. Rename the file with a new name of your choice.

You can use the same steps to copy an entire Folder and its
contents.

Create copies of two of the files in your Documents Folder.

Moving files and folders

You can move files and folders with drag and drop.

1. In File Explorer, make sure the file or folder you want to
move is visible in the File List.

N

Move your cursor over the file or folder you want to move.

w

Select the file or folder by clicking on it once.

&

Now, click and hold the Left Touchpad Button down while
you drag the file or folder to where you want to move it.

5. Release the Left Touchpad Button to drop the file or folder.

You can move files and folders with right-click cut and paste.

1. In File Explorer, make sure the file or folder you want to
move is visible in the File List.
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Move your cursor over the file or folder you want to move.
Select the file by left-clicking on it once.

Right-click on the file.

Click on Copy on the menu.

Click anywhere on the white space below the other files.
Navigate to where you want to move the file or folder.
Right-click.

Click on Paste on the menu.

O© © N o U A W

Task

Move a file from your Documents Folder to the Test Folder
you created earlier.

Sorting files

In the File Explorer App, you can choose how you want to sort
your files. This will help you find files more easily.

The four ways to sort files are by name, date modified, type and
size.

Changing Sorting Options

You can change the sorting option of files in the File Explorer
App.

Open the folder in which you wish to re-sort the files.

o~

Click on the column heading (name, date modified, type or
size) and the files will automatically be re-ordered by that
option.

Changing View Options

The View Tab allows you to change the way files are displayed
in File Explorer.

You can change the way files and folders are displayed in File
Explorer.

1. Click on the View Tab.

2. The Panes Group, Layout Group, Current view Group and
Show/hide Group will allow you to change how your files
are displayed.

w

Take time to find the view setting that works best for you.
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No-go zones in File Explorer

There are two things you should never do when you are
working in File Explorer.

Never

File types

A computer’s Operating System can handle many different
file types and uses a range of apps to create, edit or read the
different file types.

Each file type is represented by a different icon to make them
easier to identify. Each type of file also has a different file
extension.

=
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File extensions

When you look at a file in File Explorer you will see that each file
has a name. There is a full stop after the file name, followed by
three or four letters. These letters are called the file extension
and they identify what type of file it is. The full stop is read

as DOT when you read the file extension, for example, say
Test[DOT]docx for the file name Test.docx.

Associated apps

Each file type is associated with a particular app or apps.

. . File .
File content File type Associated app
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File properties

The File Properties Window shows you information about the
type of file, the size of the file, and when you last modified it.
This is useful information if you wish to check when you last
worked on a file; or if you want to see if the file will fit onto a
flash drive, for example.

When you open the Properties Window, you will see detailed
information about the file. This will include its path. The path is
like the address of the file's location on your computer’s hard
drive. This can assist you in finding a file you remember creating
but cannot find where you expected it to be.

You can access the Properties Window for a file.

1. In File Explorer, make sure the file you want to investigate is
visible in the File List.

Move your cursor over the file or folder.
Select the file by left-clicking on it once.
Right-click on the file.

Left-click on Properties on the menu. A pop-up menu will
appear with detailed information about your file.

vk W

16 © Via Afrika — These pages may not be shared.



The Properties Window

ERRYERER

File Home Share

l:] [TH Preview pane

> Quick access
fa Media24 Head Office
@ OneDrive - Media24 |

[ This PC
) 3D Objects
[ Desktop
%] Documents
& Downloads
D Music
&) Pictures
B videos
“ia Local Disk (C:)

- Google Drive (G:)
=g ViaAfrika (\\02CPT-

¥ Network

Manage

View Picture Tools

[ Extra large icons =] Large icons Mediumicons -

|| Mathematics 2021
|| My Notebook
EL OneNote Notebooks

Documents

[ Group by ~

E:H small icons EE List - [[i] Add columns ~
Navigation = = =, Sort
pa?\gv (B Details pane 2= rije fIE content °  bye [misizeallcoumnstofit [ Hidd
Panes Layout Current view
<« v A > ThisPC > Documents
~
Name Date modified Type Size

2021/03/28 18:39 File folder
2021/03/28 19:59 File folder
2021/03/28 19:57 File folder

[ item
[V File

[&] sAFlagjnc OMSOSA0740  IDGEIe, 2KB
83 Class lis| ® SAFlagjpg Properties Xt Excel W... 7KB
Mark sh ft Excel W... 7KB
138 Marks General | Securty Detals  Previous Versions <€
@ Lesson ft PowerP... 0KB
@2 Announ @ [sAagps | ft Word D... 0KB
@3 Classrog ft Word D... 0KB
Type offie:  JPG File (jpg)
o
9 _— 1 .
Location: k:\Usets\hewleh.&k\" I } File path
Size: IZ.IZKBGZSSb)tes) ! } File size
Size ondisk: 8,00 KB (3 192bytes)
Created:  Sunday. 28 March 2021, 20:07:49
Modfied:  Tuesday. 12 May 2015, 07:49:25
Accessed:  Today, 29 March 2021, 3 minutes ago
Atibutes:  [JReadonly []Hidden
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Sharing files and folders
___ External storage devices

External storage devices

External storage devices allow you to add to your laptop'’s
storage capacity by storing files separately from your
computer’s main storage on your hard drive. An advantage of
these devices is that they enable you to transfer and share your
files with others.

External storage is often used to store information that's
accessed less frequently.

There are three main types of external storage device.

CDs and DVDs

Though they might be on the brink of extinction, we must
mention CDs and DVDs as an option for storing files. With
many new laptops coming without a CD/DVD drive, fewer
people can store and access information on CDs and DVDs. The
maximum capacity of a CD is 700 megabytes, while a DVD can
hold 4.7 gigabytes.

Flash drives

Flash drives are popular for their versatility and portability.
These tiny storage devices can store up to one terabyte of
data. They connect to your computer via a USB port and make
transferring files very easy.

Be careful when you are using someone else’s flash drive.
These devices are sometimes infected with viruses and harmful
software. Ensure that you have an antivirus app installed before
sharing files by flash drive.

External hard drives

External hard drives are known for their reliability and can store
up to four terabytes or more. Just like flash drives, they slot
into the USB ports on your computer. You should follow the
same safety precautions with these devices as you do with flash
drives.
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Zip files

There might come a time when you'll need to save on storage
space, especially when you are transferring files. Zip files are

a way to do this. A zip file is a compressed version of a file or
group of files and can make transferring files easier and quicker.
In the computer world, ‘compressed” means that the file has
been reduced in size.

A zip file in Windows 10 looks like a folder with a zipper on it
and is known as a Zip Folder.

How to compress a file

You can compress files.
1. Select the file(s) to be added to the zip file.
2. Right-click.

3. Select Send To on the menu. Then click on Compressed
(zipped) folder.

4. Windows 10 will create a Zip Folder.

You can extract files from a Zip Folder.
1. Open the Zip Folder by double-clicking on it.
2. Select Extract All on the Ribbon.

3. You can change where the contents of the folder will be
placed or let Windows 10 decide.

4. Click on Extract.
5. Windows 10 will open a folder with the extracted files in it.

If you have any files stored on CDs and DVDs, move them to
your Documents Folder, or to an external hard drive or a flash
disk.
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Cloud storage

Cloud Storage allows you to store your files on the internet,
instead of on your laptop’s hard drive.

You usually get a certain amount of storage space available free
from the various providers of cloud storage like Google Drive
and Microsoft OneDrive. If you would like additional space,

you need to pay for it (much as you would pay to rent storage
space for the extra furniture you might not have space for).

Cloud storage has the advantage of having your files available
on any device that is connected to the internet. It makes it
possible for you to create a document on your laptop and then
continue working in it on your smartphone without having to
send the file from one device to the other. Cloud storage also
allows online collaboration with others that you will learn about
in Session 3.

The disadvantage of cloud storage is that you need to be
connected to the internet to access the files.

Cloud storage service providers

Cloud Storage is offered by a range of service providers.

Google Drive

Google Drive is the Cloud Storage Option from Google and is
associated with your Google account.

OneDrive
OneDrive is the option from Microsoft.

Dropbox

Dropbox is primarily a storage facility but does offer some
additional productivity tools.
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Sharing a file from OneDrive
You can share a file using OneDrive.

Open File Explorer and identify the file you want to share.
Right-click on the file.
Click on Share in the menu.

On the To ling, insert the email address of the person with
whom you wish to share the file.

AW S

5. From the drop-down menu on the right next to the email
address, decide on the permissions you want to apply to the
file.

« Select Allow editing if you want the person to be able to
edit the file.

« Select Open in review mode only if you want them only
to be able to leave comments and not be able to change
the actual file.

6. Add a message to explain why you are sharing the file.
7. Click the Send Button.

8. A pop-up message will confirm that the message has been
sent.

The person with whom you shared the document will receive a

message from Microsoft and then they will be able to open the

file.

Save a file in Microsoft OneDrive and share it with a
colleague.

© Via Afrika — These pages may not be shared.
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About the Final Assessment

At the end of this training session, you will be asked to
complete the Final Assessment.

If you complete the Final Assessment successfully, you will
qualify for your virtual badge and certificate (refer to the
sample certificate and sample badge on this page).

VIA AFRIKA DIGITAL EDUCATION ACADEMY

Certificate

has successfully completed the attendance and
assessment requirements of:

MANAGING FILES

This training is endorsed for 5 SACE Professional Development points.

Christina Watson
Chief Executive Officer

7 .
,24& basic education
= Department:
%‘@7}? Basic Education

\\ , REPUBLIC OF SOUTH AFRICA

In partnership with the Department of Basic Education.
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L Final Assessment

Indicate the ONE correct response for each question.

1 You can access the contents of your computer from the File Explorer Icon on the
Taskbar by following these steps.

(1) Click on the File Explorer Icon on the Ribbon.
° (2) Windows 10 will open the app.
5 (1) Click on the File Explorer Icon on the Taskbar.

(2) Windows 10 will open the app.

(1) Click on the Windows Explorer Icon on the Taskbar.
‘ (2) Windows 10 will open the app.

2 | Microsoft’s file management app is called :

a Internet Explorer

b | File Explorer

C Edge

3 | The Navigation Pane shows of the computer.

a | ahigh-level view of the contents

b | only the storage drives on the computer

¢ | only the folders that are used regularly

4 | You can rename files and folders using the on the Ribbon.

a Move to Command.

b | Organise Command.

C Rename Command.
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Final Assessment (continued)

Indicate the ONE correct response for each question.

5 | You can rename files and folders using the menu that opens when you right-click the
file or folder by following these steps in order.

(1) In File Explorer, make sure the file or folder you want to rename is visible in the File

List.
2) Left-click on Rename in the menu.
3
4

5) Left-click in the Text Box and change the name of the file. Do not change the file
extension when you rename a file.

(6) Press Enter.

Right-click the file or folder you want to rename.
The file name will become editable.

(@)

(3)
a

(4)

()

(1) In File Explorer, make sure the file or folder you want to rename is visible in the File
List.

2) Left-click the file or folder you want to rename.
3
4

5) Left-click in the Text Box and change the name of the file. Do not change the file
extension when you rename a file.

(6) Press Enter.

Left-click on Rename in the menu.
The file name will become editable.

()
5 (3)
(4)
()

(1) In File Explorer, make sure the file or folder you want to rename is visible in the File

List.
2) Right-click the file or folder you want to rename.
3
4

5

Left-click on Rename in the menu.
The file name will become editable.

(@)
—~~ T~ —~
~— ~— ~— ~—

Left-click in the Text Box and change the name of the file. Do not change the file
extension when you rename a file.

(6) Press Enter.

"

6 Don'tuse < > :" /\ ?* when you name a file because )

the Operating System uses symbols like these and will not accept a file name with any
of these symbols in it.

b | this will make finding files easier.

¢ | the Operating System cannot read these symbols.
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Final Assessment (continued)

Indicate the ONE correct response for each question.

7 | You can create a subfolder in an existing folder.

a | There is not enough information to give an answer.

b True.

C False.

8 | You can move files into folders by following these steps in order.

(1) In File Explorer, make sure the file or folder you want to move is visible in the File
List.

(2) Move your cursor over the file you want to move.
(3) Select the file by left-clicking on it once.

(4) Now, click and hold the Left Touchpad Button down while you drag the file to the
folder into which you want to move it.

(5) When you move the file over the folder, the folder will be highlighted.
(6) Release the Left Touchpad Button.

(1) In Windows Explorer, make sure the file or folder you want to move is visible in the
File List.

(2) Move your cursor over the file you want to move.
(3) Select the file by left-clicking on it once.

(4) Now, click and hold the Left Touchpad Button down while you drag the file to the
folder into which you want to move it.

(5) When you move the file over the folder, the folder will be highlighted.
(6) Release the Left Touchpad Button.

(1) In File Explorer, make sure the file or folder you want to move is visible in the File
List.

(2) Move your cursor over the file you want to move.
(3) Select the file by right-clicking on it once.

(4) Now, click and hold the Right Touchpad Button down while you drag the file to the
folder into which you want to move it.

(5) When you move the file over the folder, the folder will be highlighted.
(6) Release the Right Touchpad Button.
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Final Assessment (continued)

Indicate the ONE correct response for each question.

9 | You can delete files and folders using the menu that opens when you the file or
folder.

a | right-click

b | left-click

C double-click

10 | Which option contains words that will complete these sentences correctly?

To protect you from accidentally a file, or to help you get back a file you deleted
but now want to use again, Microsoft Windows uses a . This is where deleted files
and folders are stored until we either need them again or choose to delete them

a | deleting, File Explorer, temporarily, permanently

b | deleting, Recycle Bin, temporarily, permanently

¢ | deleting, Recycle Bin, permanently, temporarily

1 | Which option contains words that will complete these sentences correctly?

Although the files and folders are and are in your Recycle Bin, they will still
storage space. You should keep your Recycle Bin to save space. But remember,
once you have deleted a file from the Recycle Bin it is to get it back again.

a | deleted, take up, cleared, almost impossible

b | deleted, take up, restored, very easy

¢ | deleted, take up, cleared, almost impossible

12 | A PowerPoint presentation file has the extension .

a pptx
b .pres
¢ | .docx
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Final Assessment (continued)

Indicate the ONE correct response for each question.

13 A Word document file has the extension )

a pptx
b | Jpeg
c | .docx

14 | A photo file has the extension :

a | .phot
b | Jjpeg
C .docx

15 | An Excel file has the extension .

a .docx
b Xlsx
C Jpptx
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Uncertain about all
the new terms you are
learning about? Download our
extensive Using your laptop to

make a real difference to your
teaching Glossary booklet
to look at terms and technical
explanations.
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